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Installation Procedure

Introduction

This Support Tool isfor use with the MEI Cashflow SC Series Bill Acceptor, Cashflow 9500 Coin Acceptors,
Cashflow 7000 Coin Changers and Cashflow 690 Coin Changers.

This software, together with the Cashflow Programming Module handheld devices CPM (HIl) & CPM (USB)
supports Cashflow products both in the field and the Workshop.

The functionality enabled will depend on your license, but this may include:

Handhelds — Allows you to manage Handheld Devices, downloading files for devices, changing Audit settings
and upgrading of Handheld firmware.

Configuration — Allows you to load and save configuration to or from afile, and also a connected Bill
Acceptor, CF9500, CF690, CF7000 or Handheld device.

Audit — allows you to view stored, and retrieve new audit data from Bill Acceptor devices.
Handhelds will automatically save retrieved audits to the database on connection.

CRC —allows you to perform CRC checks on a connected Bill Acceptor device.

Diagnostics — for demonstration purposes — displays and runs various tests on a connected Bill Acceptor device.

Installing

Insert the CD and if the installation does not start automatically, Double-Click on Setup.Exein @

the CD directory and follow the on-screen instructions. sebup

Device Drivers

Leave the CD-ROM in the drive after installation and on first connection with the Bill Acceptor device or Cashflow
Programming Module, Windows will pop up awindow “New Hardware Found”.

In the “Add New Hardware” wizard, ensure the CD-ROM drive isincluded for a search for the best driver.
The driver MeiUsb.drv will be located and installed.

If Windows has a problem locating the driver automatically, the driver can be located manually on the installation
CD-ROM.

Launching the Cashflow STS Software

Double-click on the Cashflow STSicon on the desktop or select it from the Start menu to launch the application.

@%

Cashflow 5TS
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Set License Key

Each customer or copy of Cashflow STS has a unique License Key.
Thiswill normally be found on your CD cover.

When starting the application - if the license key has not been set or it isinvalid, the License Key window is
displayed:

@ Cashflow 5T5: Enter License Key AL _)ﬂ
™

Please enter your 48 digit License Key.

= —— " You License " Rundm'" '_._L- 1

License Window
Enter your License Key and click OK to continue.
If the license isinvalid, you will be prompted to try again.
If you have an exitsing License Key stored, the license key will displayed on this screen:

Cument License: 123456-7894BC-DEFDN 2-345678-94BC0E-FOT 234-55?5@-5’@&5“

An Administrator can also launch this window from the Admin menu. Y ou may need to enter a new license to
enable new features.
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Logon

The Logon screen will be shown on start-up:

= Cashflow STS: Logon x|

T -
1

mai cashflow:,

Login Id :

Password : Ml

i i i I 4 12

tIK Cancel I

Logon Window
Enter your Login Id and Password and click OK to proceed.

If enabled, the user may click on “Remember my Login Id and Password and log me in automatically”:

Remember my Login 1d and Password and log me in autamatically:.

IR SERRES TS S |

Thiswill save your username and password on this computer and log you in automatically next time you run the
application.

The administrator can disable this facility from the User Manager screen.
Initial Installation
When the system isfirst installed the only user will be “admin” with an empty password.

Y ou will be prompted to Change Password and can then set up new users with the User Manager screen.
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Change Password

If your password has been reset, or at any time from the user menu, you can change your password on the Change
Password screen:

% Change Password for Administrator X x|

Change Password for "admin’

[

0Old Password :

Mew Password :

Confirm Password - |

Ok . Cancel | B ﬁ;p - rT-hﬁl

A—

Change Password Window

Typein your old password (if set) and enter anew password that is at least 6 characters, but less than 16 characters
long.

Enter the new password again in the Confirm Password text box.
Click on OK to finish.

Note: Passwords are case sensitive.
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Main Window

After start-up the main window is displayed.
IMPORTANT: The options available to you will depend on your License and User permissions:

 MEI Cashflow STS V4,00 - Administrator (admin) ' =100 x|
File Tools Reports User Admin Window Help

| - 2 i s

L‘% i | '@ ‘ Iﬁ L — o
. i Q ﬁ ‘ l_‘] E % I = |U| |
Tt CIpen Save Primk Read Wirite Handhelds Audit CRC Diagnostics Lsers

@ Idle | % Mo Products Connected | r Mo Handhelds 3342008 12:57 PM

Main Window

Configuration Controls

The Main Configuration Controls are as follows:
Creates and opens a New Configuration for a Cashflow Product in a new Summary Window.

e
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Allows you to select a Configuration File and loads it into a new Configuration Summary
Window.

B

o
R=]

@

=]

Allows you to select a directory and filename and saves the selected Configuration to that
location.

ml =
H

Save

Sends the summary of the selected Configuration to the Printer.

Print Preview is also available from the File menu.

Reads the current Configuration from a connected Device into a new Configuration Summary

A

Window.
Read
»% Writes the selected Configuration to a connected Device.
Only settings that have Include/Change Setting checked will be written. These appear as bold
Write on the Configuration Summary Window.

Y ou can also access these through the File Menu:

File
M CEFlH-M
CIpEM. .. Chrl+O
Save... Chrl+5
Prink CErl+P
Prink Prexvigw CErl4L

Read from Device Chrl+R
Wiribe bo Dewice  ChrlWy

Werify 3

Ezxit

Handhelds

Handheld devices can be used to configure your products remotely:

Brings up the Handheld window.
t: Used for naming, organising and controlling settings and downloading files to Handhelds.
Handhelds Also allows you to update Handheld firmware.
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User Functions

= MEI Cashflow STS Y4.00 - Administrator (admin)

File Tools Reports Llser Admin  Window  Help

Logout
i_hange Password

The currently logged on user name is shown in the title bar as User Name (Login Id).

The User menu contains user management controls for all users.
Select L ogout to log the current user out and show the Logon screen.
Select Change Passwor d to change the password for the current user — on the Change Password screen.

Select Auto L ogin to toggle automatic logon on and off see the Logon screen for more details.

Administration Functions

Adrnin

Usetr Manager F9
Change License Crrl+F3

An Administration user will have access to the Admin menu and will aso have the User Manager icon on the
toolbar:

- Brings up the User Manager window.
FE This allows the administrator to Add and Remove users, change Login Ids and User Names
Llsers and also turn on or off the ability to log in automatically.

Select Change L icense to load the Set License Key window. Y ou may need to use this to upgrade your license to
enable new features.

Status Bar

The Status Bar has the following sections:

System Status I
Indicates the status of the system. .

@ Configuration Loaded

% Mo Productz Connected

Product Connection
Indicates the number of products connected, or the Serial
Number if there is exactly one connected.

% 2 Productz Connected

Handheld Connection -
Indicates the number of Handheld Devices Connected or Lj 2 Handhelds
displays “No Handhelds”. l::‘] No Handhelds

Local Dateand Time

16/01/2004 | 14:43

See also Main Window - SC Series, Main Window - CF9500, Main Window — CF7000, Main Window — CF690
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Main Window - SC Series

For an SC Series Bill Acceptor you may have other options available.

IMPORTANT: The options available to you will depend on your License and User permissions:

Main Window

Configuration

Configuration | cons reflect the products connected and licensed:

Reads the current Configuration from a connected Bill Acceptor.

Writes the selected Configuration to a connected Bill Acceptor.

Writes the selected Configuration to a connected Cashflow Programming Module (USB).

Status shows the product connected:
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Shows the Serial Number of the connected Bill Acceptor if thereisonly
one connected.

Tools
Additional tools available for the SC Series Bill Acceptor include:

Brings up the Audit window.
Allows you to retrieve audit from a connected Bill Acceptor and save it to the database or load
and view previous audits retrieved from a Bill Acceptor or by a Handheld.

Brings up the Cyclic Redundancy Check (CRC) window.
This allows Regulators or other users to perform CRC checks directly on a connected Bill

Acceptor.

Brings up the Diagnostics window.
This allows you to perform Self-Tests on a connected Bill Acceptor.

Y ou can also access these through the Tools Menu.
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Main Window - CF9500

After reading from a CF9500 Coin Acceptor the Main Window will look as follows:

IMPORTANT: The options available to you will depend on your License and User permissions:

Main Window

Configuration

Configuration Icons reflect the products connected and licensed:

Reads the current Configuration from a connected CF9500.

Writes the selected Configuration to a connected CF9500.

Writes the selected Configuration to a connected Cashflow Programming Module (HI1).

Status shows the product connected:

Shows the Serial Number of the connected Coin Acceptor if thereisonly
one connected.
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Main Window - CF7000

After reading from a CF7000 Series Coin Changer the Main Window will ook as follows:

IMPORTANT: The options available to you will depend on your License and User permissions:

Main Window

Configuration

Configuration I cons reflect the products connected and licensed:

Reads the current Configuration from a connected CF7000.

Writes the selected Configuration to a connected CF7000.

Writes the selected Configuration to a connected Cashflow Programming Module (HI1).

Status shows the product connected:

Shows the Serial Number of the connected Coin Changer if thereis only
one connected.
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Main Window - CF690

Cashflow STS V4.00 introduced support for the CF690 Series Coin Changer. After reading from a CF690 Changer
the Main Window will look as follows:
IMPORTANT: The options available to you will depend on your License and User permissions:

Main Window

Configuration
Configuration I cons reflect the products connected and licensed:

Reads the current Configuration from a connected CF690.

Writes the selected Configuration to a connected CF690.

Writes the selected Configuration to a connected Cashflow Programming Module (HI1).
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Tube and Designator Calculator

This function allows the user to calculate the tube size and designator size for arelevant coin, thus enabling them to
create their own specific payout configurations. The required input parameters are coin diameter and coin thickness.

Status shows the product connected:

Shows the Serial Number of the connected CF690 if there is only one
connected.
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Handhelds

Click on the Handhelds button to launch the Handheld Devices window.
The Handheld Devices window will be displayed:

Handheld Devices Window

The Handheld Devices Window contains the Handheld Tree View together with tabs containing General Details and
Advanced Settings on the selected handheld device.
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Handheld Tree View

The Handheld Tree View shows all the Handheld devices that have been registered to this
installation or database:

It allows you to organise your handheld devices into meaningful Groups.

Groups

Double-click on a group to open or close the group folder:

Click into a selected group name to edit the name in the tree:

See the Groups section in General Handheld Details for moving devices and creating new Groups.

Handheld Devices

There are two types of Handheld devices: CPM (USB) and CPM (HI1) they are distinguished by the type of icon
used for their display.

All Handheld devices that have been connected to this installation or database are shown on the screen whether they
are connected or not.

This allows you to check the settings and downloaded files that were remembered from the last time the device was
connected.

Theiconsin the tree view are as follows:
For CPM (USB)

e Device not l:: Connected 0 Connected Connected

L Connected with no file with files and Busy
For CPM (HII)

v Device not ln:: Connected Connected Connected

L Connected with no file with files and Busy
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Theright hand frame shows details of the selected Handheld Device.

Click on a selected Handheld to change the device’s name in the tree:

Y ou can change a name whether the device is connected or not and this will update the name on the device next
time it is connected.

Status Bar

The progress bar shows the progress being made of any action on a Handheld Device:
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General Handheld Details

Thistab contains General Details about the handheld, including the Name, Serial Number, Group and Files.

Name

This displays a user-assigned name for the Handheld. This could be the name of the Handheld user or another Id.
Typein the text box and click Set or change the name in the tree view.

Changing the name is valid whether connected or not, if not connected the name will be updated on the device the
next time it is connected.

Serial Number

This displays the serial number of the unit — whether connected or not.

Group

This displays and allows you to change the group to which the Handheld is assigned.

Changing the group is valid whether the Handheld is connected or not, as thisinformation is only stored in the
Support Database.

Click on New to create a new group.
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Files

This frame shows all the Files currently loaded onto a Handheld whether it is connected or not.

Theiconsfor CPM (USB) are as follows

Bill Acceptor (I mei Bill Acceptor E Bill Acceptor = Bill Acceptor
Bootloader * Application Variant b Configuration
Firmware Firmware Firmware Settings

Theicon for CPM (HII) is asfollows

A Configuration files
l, .]

When connected click on Download File to locate files to download. The following file formats are accepted:

Extension(s) Type Description

* XCF, XML Configuration Files | This may contain Firmware, Currency and Configuration data -

* XML, * . XPS created using the main configuration controls.

* BIN SC Series Firmware Allows you to download Bill Acceptor firmware onto a
Cashflow Programming Module (USB)

Click on Delete File to delete the currently selected file.
Click on Delete All to delete al the files on the handheld.
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Advanced Handheld Settings

The second tab contains Advanced Details and Tools, including Power-Ups, Errors, Firmware Versions and Audit
Settings.

Power Up Count

Shows the number of Power-Ups or Usage count since it was last reset.
Click on Reset Count to reset this number to zero.

Error Count

Shows the number of Errors that occurred on the Handheld since they were last cleared.

Click on View Errorsto show the Error L og window.

Firmware Versions

This displays the current firmware versions on the Handheld device.
Separate Firmware blocks exist for Application, Bootloader, USB Slave and USB Master.
Click on Upgrade to locate a“*.cfu” or “*.cfh” firmware file which can be downloaded to the Handheld.

The file names will contain “app” for Application, “sbl” for secondary Bootloader, “util1” for USB Slave and
“util2” for USB Master.
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Audit Retrieval Settings

This allows you to change settings for automatic audit retrieval.

Set Automatically Download from Bill Acceptor to make the Handheld retrieve audit data from a Bill Acceptor
when it connects — this audit data will automatically be retrieved from the Handheld and saved to the Audit
database.

Set Clear Audit to make the Handheld clear audit information from a Bill Acceptor after it finishes any other tasks.
Thisframe is not displayed for CPM (HI1) devices asit is not applicable.

Advanced Tools

Un-Register Handheld allows you to unregister a connected Handheld device.
This removes the device from the database and releases the Handheld so another licensed customer can use it.

Format Filesystem formats and checks the file system of a connected Handheld device.

Handheld Error Log

The Handheld Error Log Viewer shows any errors that may have occurred on the Handheld since the log was last
cleared:
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Upgrade Handheld

This window will be displayed when the system detects that a handheld upgrade is available.

Upgrade Handheld Window
The Serial Number and Name of the handheld requiring an upgrade is displayed.
If you select Y esthen afirmware upgrade will be initiated.
A progress bar will be displayed indicating the download status.

Y ou can select No to defer this operation although it is generally recommended to perform updates when available.
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Cashfow Programming Module

Cashflow™ Programming Module is a Handheld device that can be programmed with Firmware and Configuration
Files and used to collect audit from Bill Acceptors.

The Handheld connects to the PC and Bill Acceptor viaa USB cable.

The device gives feedback through two LED s when communicating to the product, the following table can be used
to interpret the codes:
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Configuration

Using Configuration Controls, configurations can be created as:
New documents.
Read from a Bill Acceptor, CF9500, CF690 or CF7000
Opened from a saved file.

Once a configuration has been loaded it is displayed as a Configuration Summary document.
The document can edited and can then be:

Saved as afile

Written to a device.

Configuration Summary

The configuration settings are displayed in the Configuration summary window:

Thefirst four items from each group are displayed, click on the More button to see the complete list of itemsin that
group.
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Edit Configuration Settings

Editing Text Items
To set the valug, click on Include/Change Setting and type in the edit box.

Selecting From a Range

To set the valug, click on Include/Change Setting and then type in anumber, or click on the Spin buttons to select
desired value.

Selecting From a Drop-Down List
To set the valug, click on Include/Change Setting and then click on the Down button to display the list of options.
Click on the option you wish to select:

Extendable Lists
Some lists may not be fully populated until Channelsets are loaded:

After loading a channel set may become;
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DescriptiveLists

Other list may become more descriptive once a channel set is loaded:

After loading a channel set may become:

This detail is also shown in the summary window:

Selecting From a List Control
To set the value, click on Include/Change Setting and then click on the option you wish to select.

Editing Binary Coded Values
To set the value, click on Include/Change Setting and then click on the values you wish to set.

The BCO value will be re-calculated on each value click.

This detail is also shown in the summary window:

Selecting From a Combination Control
A combination control allows you to select afrom number of predefined values or set avalue within a certain range.

Click on Include/Change Setting and then either click on the option you wish to select, type in avalue or use the
Spin buttons to set to the number required.
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Selecting From a Firmware Control

A firmware control allows you to select a firmware file to be downloaded to a connected unit.

Click on Include/Change Setting and then click on the Load button, afile dialog will appear to allow you to
navigate to the firmware file of your choice.
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Bill Acceptor Audit

Click on the Audit tool bar button to launch the Audit window.

The Bill Acceptor Audit window will be displayed:

Bill Acceptor Audit Window

Read from Device

Use the Read from Device controls to Read and Reset Audit data on an attached unit.

Click on Retrieve Audit to read from a connected Bill Acceptor.
Click on Reset Audit to re-initialise the non-lifetime audit values on the Bill Acceptor.

The Cashflow Handheld device can be set up to retrieve audit automatically.
This Audit Datawill be retrieved from the unit and saved to the database on connection.
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Audit Database

Use the Audit Database controls to Load and Save Audit to and from the Database.

Click on Save Audit to save a Retrieved Audit to the Database.
Click on Load Audit to launch the Select Audit(s) window:

Select date from which, you require Audits.
Select Unit Serial Number from the list of audits available.
Click on Select Historic Auditsto list all audits retrieved for that unit:

Select more than one audit from the list if you wish to combine the results:

When Recent or Historical selection made, click OK to load the audit required.
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Export Audit

Y ou can select one or more auditsin the list and click Export.

Then if you select a directory/filename - it will save the selected auditsto afile in the directory - e.g. "123456789
(1).xaf".

It will use the serial number of the unit as the main filename, and if there are more than one, but with different dates
it will number them.
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Import Audit

If you click on Import you can select any number of filesto import into the database:

If the audit record already existsin the database (i.e. thereis arecord with the same Serial Number and Date and
Time) then you will be told it is not unique.

Otherwise the records will be added to the database and you can view and analyse them in the normal way.

Delete Audit

If you right click on any selected auditsin thelist - you can select Delete Audit.
After you confirm the deletion these audits and associated values will be removed from the database permanently.
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General Audit

General audit values are separated into separate audit tabs:
Summary tab contains Calculated or Derived values.
General, QP Measures and Failures tabs contain other values stored by and retrieved from the Bill Acceptor.

For more help on the audit item definitions, please refer to the Cashflow STS help.

Bill Audit

The Bill Audit tab shows the notes with their descriptions and audit values retrieved or calculated from the Bill
Acceptor data.

Quantity Accepted — shows the actual number of notes accepted.

% Of Total — shows the number of bills accepted as a percentage of all notes accepted.

Total Value — showsthe total value of this quantity of notes.

% Of Taking — shows the value of each hill type shown as a percentage of the overall value of notes accepted.
Audit Accept Rate —is based on the number of notes recognised vs. the number stacked.
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Cyclic Redundancy Check (CRC)

Click on the CRC toolbar button to launch the Cyclic Redundancy Check window.
The CRC window will be displayed:

Bill Acceptor CRC Window
Regulators can use this window to perform a CRC check on a connected Bill Acceptor device.
Enter an 8 character hex value O-FFFFFFFF into the Offset/Address text box.
Enter a4 character hex value O-FFFF into the Seed Value text box.
Click on the Calculate CRC button.
The Bill Acceptor isinterrogated and the CRC value is displayed in the window.
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Bill Acceptor Diagnostics

To launch the Diagnostics window, click on the Diagnostics toolbar button.

The Bill Acceptor Diagnostics window will be displayed:

Bill Acceptor Diagnostics —
The Bill Acceptor Diagnostics window allows you to run basic tests on a connected Bill Acceptor Device.

The diagnostic toolbar contains the following options:

Runs all tests: Self-Test 1, Self-Test 2 Prints the test report shown on
and also reads the Current Configuration. the Test Report tab.

Loads test results from afile. Saves test results to afile.
Clearsresults.
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Self-Test 1

Thisruns the basic self-test on the Bill Acceptor and shows the results on the screen.

Click Run to run test on the connected Bill Acceptor device.

Test Results
A passresult isindicated by a Green display.
A negative result is shown in Red.

R

If your Bill Acceptor has aversion of Software that does not support Diagnostics - this will be indicated:

R
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Test Item Details
Double-click on any test item to show test item details:

Double-click on any test item to show test item details:
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Self Test 2

Thisruns aBuilt in self-test on the Bill Acceptor, but requires user instructions, actions and/or user confirmation:

Bill Acceptor Diagnostics —Self Test 2
User Confirmation

The user is asked to initiate and confirm certain events.

Event Event Confirmation
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Test Report

Bill Acceptor Diagnostics — Test Report

Test in Progress
If the test has not completed then thisisindicated at the top of the report:

Grey sectionsindicate any untested parts:

Click on "Read Configuration” to load the current configuration from the Bill Acceptor.
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Test Failures
If there are any failuresthisisindicated at the top of the report:

Red sections give details of failures:

Test Details

Click on to edit operator name and enter any operator notes:
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User Manager

Click on the Users button to launch the User Manager window.

The User Manager window will be displayed:

User Manager Window

The User Manager window allows an administrator to control a user’s access to the system.
To add a new user click on the Add button.

The Logon Id and Name of a selected user can be changed in the boxes situated to the top right of the
window:
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The User Permissions for a selected User can be changed in the User Permissions view — this allows the
administrator to Enable/Disable different features for a particular user:

Note: The features displayed will depend on your license permissions.

Click on Reset Password to clear the selected user® password this will result in the user being asked to
set a new password the next time they logon. This feature enables the administrator to recover if a user
forgets their password.

To delete a user from the system click Remove. This will permanently remove the user from the system.

Checking Allow Auto_Logon for all users will allow all users to select Auto Logon — so their machine will
remember their User Name and Password and log them in automatically next time they run the system.
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Error Handling

If an Error occurs - the Error window will be shown:

The user can cause thiskind error by disconnecting the Bill Acceptor, while trying to read data fromiit.
For non-user errors - Click on Details >> to show details of the Error.

This can be fed back to MEI if the problem persists.

Click on Save L og to create atext file containing al errors, warnings and messages generated since the application
started.

Click on Copy to paste errors, warnings and messages to the clipboard.

°MEI, 2006 Page 45 Rev: G2



CashFlow® STS User Manual

Help/About

Select About from the Help menu to display the About window:

About Window
This displays the Support Tool version and MEI part numbers of all of the components used for this software.
Click System Info... to display standard Windows system information.
Thisinformation can be saved to afile and sent to MEI for analysis.
Thisis helpful in diagnosing system faults.

Contact MEI Technical Support on 1-800-345-8172 or visit http://www.meigroup.com for more information, help
or support.
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